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Presenter Notes
Presentation Notes
Before we begin:

This is one in a series of workshops around EndNote.

They range from introductory level (Introductory I) up to intermediate level (Intermediate II)

Taken together, they will cover the main points you need to know in order to use the software

We can’t fit everything you need to know in a single workshop, so sign up for the others, look at the PPTs / transcripts (as they become available) for further information

This workshop isn’t going to be delivered live as it will be covering the ‘look & feel’ of EndNote. It is strongly recommended that you go through this presentation before attending any of the other EndNote workshops as there won’t be time to repeat all the material covered here.




Session Content

• Where to download 

• How to create your library

• The ‘look and feel’ of EndNote

• Help & further information

Presenter Notes
Presentation Notes
This introductory session will not be looking at how to use EndNote – it will focus on finding and downloading the software, and then will go through the main features which you are likely to want or need to use.

Future workshops will cover how to use EndNote, so look at the session content list on the booking page for each workshop to see what will be covered in which session, to make sure that you sign up for the session you need.



Learning Outcomes

By the end of this session, you should:

• Know where to find EndNote to download it

• Understand the process of creating a library and setting 

up your preferences so that you’re ready to use EndNote
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Getting started 
Download EndNote

Presenter Notes
Presentation Notes
All members of the University of Derby get free access to the full version of the EndNote Reference Management Software to use on their own devices. We now have access to EndNote 21 which is the latest version.

This will only be available for the duration of your programme so, if you want to preserve your library content to use after you’ve graduated – if you’re going into research for instance, you will need to make sure that you have exported your library in a format compatible with the reference management tool you will use later.

This will be covered in a later session so don’t worry if you don’t remember this later – you will be reminded.

If you’re a member of staff, or you’re a student who wants to use EndNote on a university PC or laptop (so not your own device) you will need to open EndNote via AppsAnywhere – and the tile for AppsAnywhere should be on the desktop of all university laptops and PCs.



Start in Course Resources

• Log in to UDO & go to the Course Resources home / landing page

• Look for the ‘Software Downloads’ link

• Click on it to see the list of software available through the university

Click Me!

Presenter Notes
Presentation Notes
First of all ,you will need to log in to your UDO account and go to the Course Resources landing page (just click on the Course Resources tile in UDO)

On that page there should be a link for Software Downloads and clicking it will take you to a list of the programmes available to students and staff to download onto their own devices. There is a screenshot on the next slide but bear in mind that if new software has been added its appearance may not be identical to the image shown.



Click on EndNote to download the software to your device

EndNote Installation guides (you 

will need to be logged into Course 

Resources to open up the relevant 

PDF)

Windows Installation Guide

Mac Installation Guide

If you have problems downloading, 

please check the IT Knowledge 

Base and from those pages you will 

also be able to log in and create a 

query ticket or use the live chat to 

speak with IT personnel.

Click Me!

Presenter Notes
Presentation Notes
Downloading EndNote
Click on the EndNote link to start the software download. 

There are instructions from DS&S (formerly IT Services) on how to install EndNote onto your device, so that process will not be covered here. 
If you find that you are having trouble installing EndNote onto your device, or that you are getting error messages, remember to contact IT Services for help, either by visiting the website, via email or by going to the help desk in ‘B’ Block, on the second floor. 
 
If, after installing the software, you have difficulties using EndNote – either inputting data, or exporting references to a Word document, please contact the library for advice, either by emailing library enquiries, or via the online chat – look for the chat bubble on the bottom right of any library web page.

https://alt-60def59bafa37.derby.ac.uk/bbcswebdav/institution/Software/EndNote/EndNote%2020%20Download%20and%20Install%20Guide%20Windows.pdf
https://alt-60def59bafa37.derby.ac.uk/bbcswebdav/institution/Software/EndNote/EndNote%20X9%20Download%20and%20Install%20Guide%20macOS.pdf
https://itservicecentre.derby.ac.uk/hc/en-us
https://itservicecentre.derby.ac.uk/hc/en-us


Warnings!

• Make sure you keep your EndNote Library on your 
hard drive – don’t move it to the cloud

• There are two parts to each library – a data folder 
and your EndNote library file.

• Make sure you keep them both together

• Try to give your library a meaningful name to make it 
easier to find – otherwise EndNote will use the default, 
‘My EndNote Library’

Presenter Notes
Presentation Notes
Don’t move the folders to a cloud-based storage system as this can often lead to file corruption…so you would basically have to start all over again!

If you separate the two files, then your library won’t work

If you create more than one library, and you can, you don’t want them all to be called different versions of ‘My EndNote Library’ so having a meaningful library title is a good idea



EndNote Libraries in File Explorer

The files of data in your 
EndNote Library e.g., 

PDFs, record content etc.
The Library itself – 

this is what you 
click on to open 

the Library 

Presenter Notes
Presentation Notes
One file will have your library’s name with a suffix of .Data e.g., Research Library.Data and the icon will be a yellow folder. In the File Type column, it will say, ‘File Folder’.

The second file will just have the name of your library e.g., Research Library and the icon will be the purple and white EndNote icon. In the File Type column, it will say, ‘EndNote Library’.

Think of your library file as a filing cabinet, and the data file as the contents of that cabinet.



Image of 
open / 

create library 
dialog box

Presenter Notes
Presentation Notes
Find EndNote in your programme files and open it up (in Windows this will be under the Windows logo button where it displays a list of programs you can access – it may also have been added to Start)

When you click on the link to open EndNote, a dialog box will appear asking you whether you want to Open an existing library, or Create a new library - you'll need to select the option to Create a new library 

You’ll be able to give your new library a memorable filename if you decide to change it from the default
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Using your 
EndNote  
Library

Presenter Notes
Presentation Notes
The next few slides will be image-rich as there are a lot of screenshots to cover the different elements of EndNote and what functions you can expect to find where.
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EndNote’s 
‘look and feel’

Presenter Notes
Presentation Notes
This section will focus on how EndNote looks, what the different sections are and will briefly cover what those sections help you do.

We will not be going into detail as that will come in future workshops.
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EndNote’s home page

Presenter Notes
Presentation Notes
EndNote’s home page has four (4) sections

Central section to display brief references

Action tabs on the upper left of the page

Action icons on the upper right of the page

Resources in left-hand sidebar

Only some of these items will be covered in detail in this presentation. Ones which aren’t covered will be gone over in the intermediate presentations.




Central section

Brief information according to the default field display 

Presenter Notes
Presentation Notes
Central section of the screen to display brief references

Gives you a brief look at the items in the selected folder depending on the criteria that you have selected for display.

Default criteria are attachment, author, year, title of the item, journal title (if it’s an article record), reference type (e.g., article).

If you open the reference (by double-clicking) information will display on the right-hand side of the screen. You will see the reference information, a tab to edit the content and add data which may be missing e.g., page numbers, or volume/ issue, and a tab to view the PDF (if attached) of the item. You will also be able to open the PDF in a new window so that you can have a better viewing experience.




Action tabs on the upper left of the page 

Presenter Notes
Presentation Notes
Action tabs on the upper left of the page (running from left to right)
File
Edit
References
Groups 
Library
Tools
Window
Help




Action icons on the upper right of the page

Presenter Notes
Presentation Notes
Action icons on the upper right of the page (running from left to right)
Insert a citation for each selected reference
Add a new reference to the selected group
Share this group
Export references to another file or library
Search the web for full-text documents for the selected references
Create a Web of Science Citation report from the selected references




Resources in left-hand sidebar

Top 

Presenter Notes
Presentation Notes
Resources in left-hand sidebar
Top section
Sync [Synchronise Configuration]
All References
Recently Added
Unfiled
Trash

Middle Section
My Groups
Find Full Text
Groups Shared

Bottom Section
Online Search
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A closer look

Presenter Notes
Presentation Notes
Over the next couple of slides, we’ll be looking at some elements of some of the action buttons on the top-left of the EndNote home page.

Remember, elements not covered here may be in subsequent workshops.



The ‘File’ tab

• Close Library

• Save a Copy

• Import
• File
• Folder

Presenter Notes
Presentation Notes
There are quite a few items visible in this screenshot of the options under the file tab, but the only ones to mention here are the following:

Close Library

Save a Copy

Import – either a file or a folder containing multiple PDF files

These are the three that you are most likely to use starting out.

Close library is self-explanatory; it’s a good idea to close your library before exiting out of the programme.

Save a copy is a useful option, especially if you’re adding lots of references to EndNote, as this will create a backup so that if your original file becomes corrupted or otherwise inaccessible you will have the copied version to fall back on.

And finally, the Import function – one of the most key tools you will use in EndNote. 

The Import File option lets you either add a collection of references which you’ve exported from one of our databases as e.g., an RIS file, or you can import individual PDFs. 
The Import Folder option lets you import multiple PDFs at a time, if they’re saved in the same folder.




The ‘Edit’ tab

• Change appearance 
• Case

• Font

• Size

• Style (e.g., bold / italic etc.)

• Preferences

Presenter Notes
Presentation Notes
Under the edit tab the key features are to change the appearance of EndNote and the text of the records you store there and, most important, the preferences option. 

This is something we’ll come back to later in the setting up section of the workshop.



The ‘References’ tab

• New Reference

• Copy References To

• Find Full Text

Presenter Notes
Presentation Notes
There are several elements on this tab but key ones to mention are the options of creating a New Reference – this would be manually creating it by filling out a record for whichever item you want to add to EndNote.

The Copy References To option is if you want to copy your references into a second, pre-existing library or into a new library that you create there and then.

The Find Full Text option will be very important once you’ve gone through your articles and decided which ones to keep as it will do a lot of the heavy work of finding full-text links and PDFs in our library subscriptions and attaching them to the relevant records. This option will be covered in more detail in another workshop.



The ‘Groups’ tab

• Different group options

• Most key is ‘Create Group’

• Researchers doing systematic reviews / 

larger pieces of research may find ‘Create 

Smart Group’ or ‘Create From Groups’ useful 

as well

Presenter Notes
Presentation Notes
When you’re doing research, one of the most important things you need to do is stay organised. Just adding your references to EndNote isn’t enough to keep organised, especially if you’re searching more than one database and need to fill out a PRISMA flow diagram and record your search process.

You can manually Create a Group and name it whatever you want, which is recommended if you’re going to e.g., put the records from database search 1 into a group, and then the records from database search 2 into another group.

You can also use the Create Group Set option to create a group which holds sub-groups. So, you could have a Group Set called, ‘Database Results’, and then within that group set have individual groups for each database you’ve searched e.g., Cinahl, Embase, Scopus, British Education Index, ACM Digital Library; or you could have sub-groups covering particular themes, or articles to use for specific assignments. You can arrange them however you feel would be most useful and keep you organised.



The ‘Tags’ tab

• New feature

• Helps with organising

• Can help with recording of 

e.g., themes

Presenter Notes
Presentation Notes
The Tags tab is a new feature in EndNote 21 and allows you to add a little more (visible) information to an item record which you can have displayed in the central panel along with the other, brief article information. 

How to use this feature will be covered in the live workshops.



The ‘Library’ tab

• Sync

• Advanced Search

• Find and Replace

Presenter Notes
Presentation Notes
With the desktop version of EndNote, you can also connect to the web version so that you can easily work away from your main device, add references ‘on the go’ via the web interface and then, when you get back to your main device, Synchronise your libraries so that any changes you made will show up in both resources – desktop and online EndNote.

You can only sync one library at a time so if you’ve created multiple libraries for different projects (not necessary, but you may have decided to do that), then you will have to choose which one to synchronise with the web-based version.


The Advanced Search option can be used when your library has a lot of content and you want to find a specific paper, or group of papers, and you haven’t used the Tags feature to organise them. Advanced search only looks within your library, it doesn’t find new articles for you.

Find and Replace can be used when you want to make bulk changes to a lot of records. You may want to change the type, or tag, and so on. If you do decide to use this option on many records, make sure that you back your library up first. Then if you’ve made a mistake, or you change your mind, you can easily return to a previous version of your library.





The ‘Tools’ tab
• Install EndNote Click

• Output Styles

• Cite While You Write [CWYW]

• Online Search

Presenter Notes
Presentation Notes
Install EndNote Click
EndNote Click is a free browser plugin that finds the best available PDF of an academic article while you browse. Behind the scenes, EndNote Click will search open databases and (where possible) your university's subscriptions to find the best version of the paper for you.

[Clarivate (2023) EndNote Click: What is EndNote Click and how do I use it? Available at:  https://support.clarivate.com/Endnote/s/article/EndNote-Click-What-is-EndNote-Click-and-how-do-I-use-it?language=en_US (Accessed: 19 September 2023)]

To install, go to Tools and select Install EndNote Click Browser Extension from the drop-down list. 
Then follow the instructions on screen to add the extension to the browser you’re using.

Output Styles
Output styles are the referencing style you want your references to be in when you use the Cite While You Write function. There are a few pre-installed in EndNote and you can add many more if the referencing style you’re going to use isn’t initially listed.
If you’re using the Harvard style of referencing, you will need to install the correct output style so that your references look correct. This will be covered in one of the live workshops.
 
Cite While You Write [CWYW]
When you install EndNote, it should automatically add an EndNote toolbar to Word so that you can use the Cite While You Write function.
This will enable you to write your work: essay, article, presentation notes, dissertation etc., and add citations and references directly from your EndNote library as you go along.
Because it will add exactly what’s there, you need to make sure that EndNote has the correct information harvested from article PDFs or from the records imported from databases, as correcting it when you’re already writing up can be time-consuming.
 
Online Search
It is possible to search a number of databases from within EndNote to locate specific references to add to your library – so not to do a formal, topic search but to look for a particular article and so on.
In the left-hand menu you may see PubMed or Web of Science already included as locations to search in. It’s possible to add additional databases to the list, but not everything we subscribe to at the university library can be added or accessed in this way.
It should be emphasized however, that it is strongly recommended to search in the databases themselves.
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Questions?
Library Enquiries
• library@derby.ac.uk  / (01332) 59 1215

Develop@Derby Hub
• https://libguides.derby.ac.uk/develop-at-derby

Library Workshops
• https://libcal.derby.ac.uk/ Research skills help

• https://libguides.derby.ac.uk/researchguides

EndNote Support (Clarivate)
• https://support.clarivate.com/Endnote/s/?language=en_US
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